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本書では、このリリースで修正された問題に関するバグ番号および内容を記載しています。また、この

リリースでの新機能に関する情報も記載しています(該当する場合)。このリリースをインストールする前

に本書を必ずお読みください。参照用に本書をハード ドライブに保存するか印刷してください。 

注意事項:  

 このリリースは、すべてのオペレーティング システムにおいて、製品のフル インストールの形

式をとっています。このリリースをインストールする前に、既存の Maya アプリケーションをアン

インストールしてください。 

 本リリースには、以前のサービス パックで行われた修正がすべて含まれています。したがって、

この拡張機能をインストールすれば、これ以前の全リリースをダウンロードしてインストールす

る必要はありません。 
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追加の製品情報  

このリリースのアンインストールとインストールの詳細手順は、www.autodesk.com/maya-install-

2013-jpn を参照してください。 

この製品のすべてのマニュアルと学習リソースについては、www.autodesk.co.jp/maya-docs を参照

してください。 

認定ハードウエアについては、www.autodesk.com/maya-hardware (英語)を参照してください。 

本リリースに関する問題をお知らせいただく場合は、www.autodesk.co.jp/maya-ss を参照してくださ

い。 

その他の参考情報については、www.autodesk.co.jp/maya-learningpath を参照してください。 

新機能 

このリリースの新機能に関する情報は、

http://download.autodesk.com/global/docs/maya2013/ja_jp/ の「Maya ヘルプ」を参照してください。 

Autodesk Maya 2013 Extension (拡張機能) 

Readme 

http://www.autodesk.com/maya-install-2013-jpn
http://www.autodesk.com/maya-install-2013-jpn
http://www.autodesk.co.jp/maya-docs
http://www.autodesk.com/maya-hardware
http://www.autodesk.co.jp/maya-ss
http://www.autodesk.co.jp/maya-learningpath
http://download.autodesk.com/global/docs/maya2013/ja_jp/
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解決された問題 

このセクションでは、この拡張機能に含まれている修正事項を記載します。 

以前のリリースで行われた修正事項の一覧は、

http://images.autodesk.com/adsk/files/Maya2013_SP1Readme_JPN0.pdf を参照してください。 

アニメーション 

バグ番号 説明  

MAYA-1423 Create a new animation layer when HIK skeleton is baked onto new layer 

MAYA-1492 Fix usage of skinCluster -skinPercent flag 

MAYA-4376 Shoulder rig using default Maya nodes doesn't evaluate correctly  

MAYA-8962 Speed up loading of some scenes with IK 

MAYA-11052 Use specified rotation order when manipulating HIK effectors in “World” mode 

MAYA-11175 Correctly blend quaternion rotations in animation layers 

MAYA-11428 HIK offsets introduced while manipulating body parts 

MAYA-11480 HIK IK Effectors not updating properly when an auxiliary effector exists 

MAYA-11537 Address manipulation rotation glitches on aligned rig 

MAYA-11796 HIK auxiliary effectors at wrong position when rig is out of sync 

MAYA-12151 Character set interferes with getAttr -t command 

MAYA-12235 Update default extension of weight map import filter to “.weightMap” 

MAYA-12417 Don’t change HIK effector visibility when undoing manipulation 

MAYA-12861 Avoid crash when deleting referenced constraints 

MAYA-12943 Sync rig on set key in full body/body part modes 

MAYA-13309 
Rotation HIK shoulder FK effector in body part mode affects the rig in full body 
mode 

MAYA-15105 Animation layers: add selected reference not working 

MAYA-15670 skinCluster influences are shown in a different order from previous version 

MAYA-155 Don’t create keyframes at current time during certain undo operations 

MAYA-792 Speed up fat connections 

MAYA-1260 
Make sure Playblast can handle multiple decimals (i.e., “.”) in the target 
filename 

MAYA-3127 Store stroke values when painting blend shapes with reflection 

MAYA-3149 Use hotkeys to advance frame in the graph editor 

MAYA-5115 Use consistent extensions when handling JPEG images 

MAYA-6032 Turn “Auto Joint Orient” option on move tool off by default 

MAYA-6155 Fix sequencer Playblast that causes image plane results to be off by one frame 

MAYA-8111 Address animCurve performance 

MAYA-10349 Avoid crashes when handling scaled keys in the graph editor 

MAYA-11099 Ensure getAttr -time returns correct value 

MAYA-11430 Avoid resetting key values to zero when using “Show Buffer Curves” 

MAYA-11545 Allow user-level control of plug-in shapes visibility in modelEditor and Playblast 

MAYA-11832 Ensure values persist if keys are deleted 

MAYA-12317 
Ensure copy vertex weights handles scenes with nodes that have the same 
name 

MAYA-12663 Correctly animate locators during playback and timeline scrubbing 

MAYA-13424 Ensure MMB and LMB have the same behavior for local constrained moves 

http://images.autodesk.com/adsk/files/Maya2013_SP1Readme_JPN0.pdf
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バグ番号 説明  

MAYA-14511 Avoid crash when hammering skin weights 

MAYA-14761 
Avoid crash when deleting keys in the graph editor and pre-select highlight is 
enabled 

MAYA-3055 Correctly handle the –sequenceTime flag during Playblast 

MAYA-3119 Avoid skipping non integer frame when stepping over timeline 

MAYA-6055 
Avoid duplicate dialog prompts when exporting an animation clip over an 
existing file 

MAYA-8291 Allow users to attach image plane using context menu 

MAYA-10171 
Avoid displaying incorrect warnings about stereo cameras when using the 
sequencer 

MAYA-12176 Referenced object on animLayer cannot be removed from AnimLayer 

MAYA-12513 
Expand time range that can be used in Trax and Sequencer from +/-100K to  +/- 
8M 

API 

バグ番号 説明  

MAYA-3180 There is no kFloatArray type for MFnData 

MAYA-6413 Duplicate MPxLocator nodes do not inherit the value of the visibility attribute 

MAYA-7897 Context tool with custom cursor doesn't work  

MAYA-10808 Extra semicolon in MFnBase.h generates spurious warning messages 

MAYA-11162 Extra semi-colon in MThreadUtils.h 

MAYA-11192 Using switch-case to implement operator[] in MVector.h and MFloatVector.h 

MAYA-11399 
Unable to attach 'transferAttributes' node object to MFnGeometryFilter function 
set 

MAYA-11715 Typo in MFileIO.h 

MAYA-11720 Getting Maya Library to run as a process 

MAYA-11734 MItDependencyGraph::getPlugPath returns path in reverse order 

MAYA-13871 blastCmd.cpp aspect ratio trouble when using fbo offscreen functions 

MAYA-15057 getApplicationVersionAsFloat() can incorrectly return 0 in certain situations  

アーティザン 

バグ番号 説明  

MAYA-6518 Paint Attributes Tool is not remembering last setting 

MAYA-15219 Object 'exportMapValueMenu' not found and artisan tools become corrupt 

Composite 

バグ番号 説明  

MAYA-1266 Overlay mode in Reaction renders incorrectly 

MAYA-1298 Correct conflicting file and directory permissions  

MAYA-9364 Color picker does not show correct luminance values for over bright pixels 

MAYA-13047 Gamma conversion on render output doesn't work 

ファイル リファレンスとファイル入出力 

バグ番号 説明  

MAYA-8901 Too slow to open scene with reference instancing 
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バグ番号 説明  

MAYA-14572 
Removing a referenced object that constrains another referenced object causes 
crash 

MAYA-15297 Crash when performing a Reference Remove 

MAYA-4502 
Object’s full DAG path not used when applying a reference edit; edits applied to 
incorrect object 

MAYA-6459 Reference Edits not saved in a callback 

MAYA-8245 Avoid crashes on file load with large scene due to memory handling 

MAYA-10445 referenceQuery liveEdits query does not return full DAG path to nodes 

MAYA-1810 Scene file crashes Maya instantly  

MAYA-9540 addAttr category not saved on File > Save 

MAYA-12812 
Creating an itemFilter with non-default classification causes a CER when 
exporting all with preserve reference checked on 

MAYA-15099 Crash with export selection 

MAYA-15966 Maya fails to open a newer binary file with ignore version turned on 

MAYA-14932 Crash when listing unloaded references 

流体 

バグ番号 説明  

MAYA-10338 Maya Fluids Auto Resize Bounding slow 

MAYA-10647 Incorrect rendering with mental ray (ocean changes levels every other frame) 

MAYA-12093 Fluid emission direction wrong when fluid is rotated 

モデリング 

バグ番号 説明  

MAYA-122 Display Alpha as Grey scale does not work in Viewport 2.0 

MAYA-774 Bad Display After cut-and-move 

MAYA-1478 Merge to Center creates history when history is disabled 

MAYA-6541 Crash when selecting vertices on Lion (10.7.2) followed by hitting the spacebar  

MAYA-9485 Interactive polygon split tool will stop unexpectedly on non-manifold geometry 

MAYA-10467 
General sets membership propagation behavior differs from ShadingEngine 
sets after polyUnite (Mesh > Combine) 

MAYA-10470 
Component set membership not propagated with certain poly operations 
(polyUnite, polyBoolOp, polySeparate) 

MAYA-10553 
ColorSets not correctly propagated for polySmooth(exponential), polySeparate, 
polyUnite, polyPoke(triangles), and polyDelEdge(invalidGeom) 

MAYA-11679 
Edit Curves > Rebuild (performRebuildCurveSet.mel script) errors when the 
curve shape is non-unique 

MAYA-11787 Merge UV doesn't work on non-default UV set 

MAYA-12125 When all Falloff Curves are set to 1, flooding soft-mod weights on vertices fail 

MAYA-12603 
polyMirrorFace and polyChipOff actions do not propagate objectSet 
membership for edges and vertices as expected 

MAYA-13141 Pressing '3' for polygon mesh causes custom viewport crash 

MAYA-14085 
RelationshipEditor only acts on "objectSet" and "character" nodetypes, and not 
nodes derived from objectSet 

MAYA-14763 polyChipOff & keepFacesTogether when set to False causes crash 

MAYA-15445 polyQueryBlindData does not return expected value after importing other object  



 

5 
 

バグ番号 説明  

MAYA-15446 
polyQueryBlindData does not return expected value after selecting UV set as 
current  

ビューポート 2.0 

バグ番号 説明  

MAYA-964 When selecting a duplicated object the unselected object gets display priority 

MAYA-1129 Material with texture project node doesn't render 

MAYA-6203 Camera override with orthographic matrix is incorrect 

MAYA-6617 Face index number has black backgrounds behind it 

MAYA-6865 Component IDs cannot be drawn on Mac 

MAYA-8208 Crash when rendering with high res settings 

MAYA-8893 DX11 effect using a geometry shader does not render, does not throw errors 

MAYA-9404 NURBS surface scene is very slow to load and update  

MAYA-9569 
DX11Shader Time and FrameNumber semantic does not provide any 
meaningful data 

MAYA-9702 Undoing a mental ray Batch Bake causes crash 

MAYA-10096 Camera scale locator doesn't update 

MAYA-10368 Joint axis do not scale to screen space 

MAYA-11024 Add support for clamp color shading node 

MAYA-11317 normalMaps not displayed as expected 

MAYA-11895 Extend MGeometryExtractor to support more than just polygonal meshes 

MAYA-12626 Painting vertex color works with per instance sharing incorrectly 

MAYA-12632 Unparenting objects from hidden parent causes corruption 

MAYA-12847 
Camera Based Selection not working for Marquee and Drag select on second 
selection (depth test state bleed) 

MAYA-13175 Crash when using custom override 

MAYA-13804 Crash when performing multiple Undo operations to CGFx Shader modifications 

MAYA-13836 Masking textures with blending does not work correctly 

MAYA-14364 Image plane not updated properly if camera parameters are changed 

MAYA-14388 Transparent objects are handled incorrectly 

MAYA-14749 Crash when deleting resources from plug-ins 

MAYA-15977 Face center doesn’t display 

レンダリング 

バグ番号 説明  

MAYA-142 
Crash when attaching Checker texture node to the Frequency ratio of the Noise 
node 

MAYA-11377 Allow PTex slice to link tools with an independent version of the PTex library 

MAYA-11903 
Crash on save (possibly due to switching the connection on cameraShape 
node) 

MAYA-12409 Alpha value of float texture image are changed by HDR image preview options 

MAYA-12885 Crash when tearing off a stereo panel a second time 

MAYA-13177 Support second UV sets in MGeometryExtractor implementation 

MAYA-13207 HLSL plug-in does not support the standard set of annotations and semantics 

MAYA-13329 Crash in TpolyHwConverter when interactively moving UVs 

MAYA-3163 Light intensity changes when photometric light's transform is scaled 
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バグ番号 説明  

MAYA-11530 Transparency set to 1.0 when using the mia_material 'Chrome' Preset 

MAYA-14019 
mia_photometric_light casts light incorrectly depending on the "shape" of the 
mental ray Area Light 

スクリプティング 

バグ番号 説明  

MAYA-11638 Group MEL command does not return unique name 

MAYA-11850 Error when exiting in standalone mode when using the PyMEL  

MAYA-14620 shelfButton default pop-up menu is unexpectedly attached to another control 

MAYA-3256 Parenting script slowdown 

MAYA-4526 Python script slowdown 

MAYA-8247 Python confirmDialog fails silently when invalid flag used 

MAYA-9103 Performance issues with TnameObject::reserveName 

MAYA-13370 Python File command pr flag causes crash 

MAYA-13767 PyMEL version "ls" command, "-long" is ignored 

Maya 一般 

バグ番号 説明  

MAYA-9321 Crash when custom node calls a MEL command and the undo limit is reached 

MAYA-10148 Channel Box can't cancel editing value by Esc key 

MAYA-10396 Window -widthHeight/-width/-height flag doesn't work 

MAYA-10703 4Double types not saved or read in .ma format 

MAYA-10810 Error with cmds.objectTypeUI for new windows 

MAYA-10916 Crash when doing hotbox gestures with RMB 

MAYA-11194 Component editor: unexpected data entry when Ctrl+LMB click 

MAYA-11334 
Expand Spreadsheet Checkbox in animcurve Attribute Editor template 
inconsistencies 

MAYA-11603 Spacebar can be used to switch views during a mouse operation 

MAYA-11630 Flag -byName in selectType and selectPriority should be split into two flags 

MAYA-11718 Editing a shelfButton causes popup menu to attach to incorrect UI 

MAYA-11822 Undo in Script Editor no longer works with the clear history buttons 

MAYA-11823 xform command does not support -ws -s in query mode 

MAYA-11856 TnamespaceManager::isAbsoluteName() optimizations 

MAYA-11980 Shift+Drag files into viewport will delete them (Windows only) 

MAYA-12209 channelBox fieldWidth cannot be changed 

MAYA-12260 File > Open dialog slow with networked machines 

MAYA-12380 Marking menu items with submenus can't be highlighted  

MAYA-12384 
Crash on close (‘x’ button) and Save, shutdown on cancel after crash is 
removed 

MAYA-12558 RGB overlay performance issues  

MAYA-12919 
Expose stack tracing into TdbTrace (dbtrace) framework and add printStack() 
option 

MAYA-12937 
editorTemplate with -addDynamicControl creates empty space in Attribute 
Editor 

MAYA-13922 Heads up display buttons not visible 

MAYA-14092 PolyTextureMenu.mel repeated arguments 
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バグ番号 説明  

MAYA-146 Stereo camera viewport breaks when tearing off and saving display state 

MAYA-14864 Querying the objectTypeUI 'listAll' argument is broken  

MAYA-14943 Hypershade Create Bar defaults to half the width of the Hypershade 

MAYA-15142 ChannelBox ‘Duplicate Values’ limited to work with only one object 

MAYA-15271 dgInfo tells does not include information about connections 

MAYA-15533 Copying 256K of text from the History in the Script Editor fails on Linux 

MAYA-1774 
Custom hotkeys not respected and connection lost on mapping of former 
press/release hotkeys (if hotkeys saved and Hotkey Editor is open) 

MAYA-1838 Channel Box selection cleared when selecting a key in the Graph Editor 

MAYA-1975 Marking menus slower with fast gestures 

MAYA-3262 qdockwidget problems 

MAYA-3288 Deleting a shelf present at start-up returns an error 

MAYA-5991 Scale tool not aligning when an object is rotated 

MAYA-6141 Switching between Attribute Editor and Channel Box is not predictable 

MAYA-6350 
Quotes and backslashes in render or animation layers break the functionality 
and cause data loss 

MAYA-7566 Crash when opening file browser while animation is playing 

MAYA-7665 Error with setParent command 

MAYA-8530 Crash when the attrcolor flag is used 

MAYA-8615 Add floating point Hue value for the new Color Chooser 

MAYA-9381 Imageplane attributes not always accessible 

MAYA-9436 
File Browser can render thumbnails for "jpg", "png", "bmp" and "tif", but not 
"JPG", "PNG", "BMP" and "TIF" (case sensitive) 

MAYA-9940 Prevent use of Shift key from causing focus issues in the Node Editor 

MAYA-2068 License error causes performance slowness 

MAYA-11573 Send To feature missing 

MAYA-890 DWG_DCE export from command line crashes Maya 

MAYA-10854 Optimize TobjImport::cleanupMesh()  

MAYA-10736 Incorrect particle motion blur at emission with mental ray 

MAYA-12128 Reposition using middle mouse button doesn't work with Rotate Tool 

MAYA-11023 Upgrade Alembic Libraries and Plugins to 1.0.5 

MAYA-9670 NVidia Quadro Gfx Driver bug: Maya crashes when gpuCache imports abc files 

 

機能の制限と注意事項 

次のセクションでは、本リリースに関する制限事項とその他の注意事項について説明します。 

制限事項 

バグ番号 説明  

MAYA-11471 
Undo after deleting a Scene representation from an assembly definition causes 
node not to work properly 

MAYA-12661 Cannot reload Scene Assembly file after changing render layer order in that file 

MAYA-12934 assemblyReference node can use invalid character for namespace (e.g. ‘1’) 

MAYA-13492 Opening files with saved Scene Assembly edits always indicate that unsaved 
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バグ番号 説明  

changes have been made 

MAYA-16009 Cannot undo removal of Scene Assembly edits 

MAYA-16354 
Edits to lattice points or curve CVs on objects contained in a Scene Assembly 
hierarchy do not display in the List Assembly Edits window 

Maya-16444 Relative file paths display as absolute file paths in the Attribute Editor 

Maya-16049 Transform values on assemblyDefinition nodes are not saved as edits 

MAYA-1475 Subdivision surfaces face selection is not visible in Viewport 2.0.  

MAYA-15567 

In Viewport 2.0, when the fall-off radius of the Soft Modification Tool is so small 
that it can only affect some control points but not edit points, then false coloring 
may not appear.  

注: 

MAYA-1436: 既定ファイル名が 2 バイト文字である場合、他のソフトウェアへのワンクリック機能を

実行するとクラッシュする 

日本語および中国語版で既定シーン名が "無題" の場合、他のソフトウェアへのワンクリック機能の実

行時にクラッシュする場合があります。この問題を避けるには、ICE 経由で他の製品に送信する前に、

シーンに 1 バイトの ASCII 文字だけを使って名前を付けてください。 

MAYA-9651: Ctrl キーを押しながら実行するホットキーで、キーがアルファベットではなく、かつ 

Shift キーを押さなければならない文字の場合、ホットキーが機能しない 

キーがアルファベットではなく、Shift キーを押して入力するものに対しては、Ctrl キーを押してもホット

キーとして機能しません。たとえば、「CTRL+]」はホットキーとして機能しますが、「CTRL+}」は機能しま

せん。これは、実質的に「CTRL+SHIFT+]」と同じであるためです。 

MAYA-11993: ゴーストによっては、ワイヤフレームに対してカラーリングが不正になる 

ビューポート 2.0 でのレンダリング順序は、他のビューポートでの順序と同じではありません。このため、

同一のオブジェクトで構成されていても、処理所順序が異なることがあり、別のオブジェクトの上から描

画してしまう可能性があります。アニメーション レイヤのゴースト化では、この現象がよく起こります。 

MAYA-16277: ビューポート 2.0 で DX デバイスを用いたデバッグ モードのための環境変数 

この環境変数を使用すると、ビューポート 2.0 用プラグインの開発中にグラフィックス カードの問題を

デバッグすることができます。また、この機能を利用するには DirectX SDK をインストールする必要が

あります。MAYA_FORCE_DX_DEBUG_DEVICE を 1 に設定します。こうすることで、ビューポート 

2.0 で DirectX モードを使用しているときに、D3D11_CREATE_DEVICE_DEBUG フラグが有効にな

っていれば、DirectX デバイスが作成されます。 

GPU キャッシュ: Maya に同梱の HDF5 ライブラリがスレッドセーフではない 

Maya に同梱の HDF5 ライブラリはスレッド セーフではありません。「--」でスレッドセーフを無効にして

コンパイルされています。 
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しかし、プロファイリングによると、スレッドセーフではない HDF5 のほうが、スレッドセーフにしたバージ

ョンよりもパフォーマンスの面で優れています。現在のところ Maya は Alembic を単一のスレッドとして

起動するため、安全に使用することができます。 

MAYA-14706: イメージ プレーン シーケンスで固定イメージ プレーンを使用すると、ビューポート 

2.0 の動作が遅い 

添付されたイメージ プレーンを切り替えてイメージ シーケンスの使用から単一イメージの使用に戻すと

きに、タイムラインへのコンストレイントが除去されません。したがって、イメージがフレームごとに再読

み込みされます。 

回避策: イメージ番号(Image Number)フィールドに連結されているエクスプレッションを接続解除する

ことにより、コンストレイントを削除します。 

MAYA-16289: ビューポート 2.0 では、負のスケールが影響し、バックフェース ポリゴンが黒く表示

される 

DirectX 11 の シェーダ アトリビュート エディタにある両面ライティング(Double Sided Lighting)オプシ

ョンが有効なときに、負のスケールによってバックフェース ポリゴンを黒く表示する可能性があります。

スケールを負にした後に、法線を反転させる必要があります。 

MAYA-14552: Maya 2013 がプラグイン マネージャの非表示ディレクトリを読み込んでいる 

Maya 2013 では、モジュールのサブフォルダが再帰的にパースされていました。Maya 2013 

Extension では、Maya は既定でサブフォルダを検索しません。検索でサブフォルダを含めるには、そ

のフォルダに対して再帰的動作を要求します。その方法は、次の例に示すように、モジュール定義ファ

イルで[r]キーワードを使用します。 

[r] scripts: ..¥..¥CommonFiles¥scripts  

 

.フォルダ(すなわちドット '.' で始まるフォルダ、別名隠しフォルダ)は、[r] キーワードが設定されていても

無視されます。このフォルダは再帰的にパースされることはなく、モジュールやスクリプトのファイル パ

スに追加されることもありません。 

MAYA-16196: オブジェクト ソート透明度のための新アルゴリズム 

Maya 2013 Extension では、レンダラ > ビューポート 2.0 (Renderer > Viewport 2.0)からアクセスす

るオブジェクト ソート透明度オプションに、新しいアルゴリズムを使用しています。これにより、より正確

な結果が得られます。従来(Maya 2013)のオブジェクト ソート用アルゴリズムに戻すには、

MAYA_OBJECT_SORT_USING_BOUNDING_BOX を 1 に設定します。 
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MAYA-14871: リグ(ペアレント コンストレイント)を操作中に頂点アニメーション キャッシュが更新さ

れない 

ビューポート 2.0 で頂点アニメーション キャッシュを有効にした状態で、ペアレント コンストレイントを持

つキャラクタ アニメーション リグを使用すると、リグの調整時に更新の失敗が起きることがあります。 

回避策: リグの調整中は頂点アニメーション キャッシュを無効にし、再生およびレビューする前に有効

に戻します。 
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	MAYA-9651: Ctrl キーを押しながら実行するホットキーで、キーがアルファベットではなく、かつ Shift キーを押さなければならない文字の場合、ホットキーが機能しない
	MAYA-11993: ゴーストによっては、ワイヤフレームに対してカラーリングが不正になる
	MAYA-16277: ビューポート 2.0 で DX デバイスを用いたデバッグ モードのための環境変数
	GPU キャッシュ: Maya に同梱の HDF5 ライブラリがスレッドセーフではない
	MAYA-14706: イメージ プレーン シーケンスで固定イメージ プレーンを使用すると、ビューポート 2.0 の動作が遅い
	MAYA-16289: ビューポート 2.0 では、負のスケールが影響し、バックフェース ポリゴンが黒く表示される
	MAYA-14552: Maya 2013 がプラグイン マネージャの非表示ディレクトリを読み込んでいる
	MAYA-16196: オブジェクト ソート透明度のための新アルゴリズム
	MAYA-14871: リグ(ペアレント コンストレイント)を操作中に頂点アニメーション キャッシュが更新されない



